Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is designed only for use with this Epson scanner. Epson is not responsible for any use of this information as applied to other scanners.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

A Note Concerning Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any Epson product. While some countries’ laws permit limited copying of copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. Contact your legal advisor for any questions regarding copyright law.

Trademarks

Epson is a registered trademark, and Exceed Your Vision and Matrix CCD are trademarks of Seiko Epson Corporation.

ColorTrue is a registered trademark, Micro Step Drive is a trademark, and Epson Store and SoundAdvice are service marks of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.
Contents

WELCOME 7
About Your Scanner 7
About Your Software 8
Getting More Information 9
Warnings, Cautions, Notes, and Tips 9

Chapter 1 GETTING STARTED 11
Unpacking the Scanner 11
Choosing a Good Place for the Scanner 12
Turning the Scanner On and Off 13
Connecting the Scanner to Your Computer 14
Connecting to a USB Interface 14
Connecting the Scanner to a SCSI Interface 15
Installing the Software 16

Chapter 2 HOW TO SCAN 19
Placing Your Original Document 20
Scanning to a File With EPSON Scan 21
Basic Scanning in Home Mode 22
Scanning in Office Mode 24
Advanced Scanning in Professional Mode 26
Scanning Documents With PaperPort Deluxe 28
Scanning Text for Editing 31
Scanning Photographs With Adobe Photoshop Elements 32
Scanning With the Start Button 35
Setting Up the Start Button in Windows 98, Me, or 2000 36
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selecting the Scanning Area in the Preview Window</td>
<td>37</td>
</tr>
<tr>
<td>Scanning Tips</td>
<td>38</td>
</tr>
<tr>
<td>Selecting Resolution</td>
<td>38</td>
</tr>
<tr>
<td>Scaling (Resizing) Images</td>
<td>39</td>
</tr>
<tr>
<td>Scanning Color Images</td>
<td>39</td>
</tr>
<tr>
<td>Chapter 3 USING OPTIONAL EQUIPMENT</td>
<td>41</td>
</tr>
<tr>
<td>Automatic Document Feeder</td>
<td>42</td>
</tr>
<tr>
<td>Installing the Automatic Document Feeder</td>
<td>43</td>
</tr>
<tr>
<td>Scanning With the Automatic Document Feeder</td>
<td>45</td>
</tr>
<tr>
<td>Fixing Document Jams</td>
<td>47</td>
</tr>
<tr>
<td>Installing the IEEE 1394 FireWire Scanner Interface Card</td>
<td>48</td>
</tr>
<tr>
<td>Installing the Network Image Express Card</td>
<td>50</td>
</tr>
<tr>
<td>Chapter 2 MAINTENANCE</td>
<td>53</td>
</tr>
<tr>
<td>Cleaning the Scanner</td>
<td>53</td>
</tr>
<tr>
<td>Transporting the Scanner</td>
<td>54</td>
</tr>
<tr>
<td>Chapter 5 SOLVING PROBLEMS</td>
<td>55</td>
</tr>
<tr>
<td>Diagnosing Scanner Problems</td>
<td>56</td>
</tr>
<tr>
<td>Problems and Solutions</td>
<td>57</td>
</tr>
<tr>
<td>Scanner Problems</td>
<td>57</td>
</tr>
<tr>
<td>Software Problems</td>
<td>60</td>
</tr>
<tr>
<td>Quality Problems</td>
<td>60</td>
</tr>
<tr>
<td>Uninstalling and Reinstalling EPSON Scan</td>
<td>64</td>
</tr>
<tr>
<td>Where To Get Help</td>
<td>64</td>
</tr>
<tr>
<td>Epson Technical Support</td>
<td>64</td>
</tr>
<tr>
<td>Speak to a Support Representative</td>
<td>65</td>
</tr>
<tr>
<td>Purchase Supplies and Accessories</td>
<td>65</td>
</tr>
<tr>
<td>Other Software Technical Support</td>
<td>65</td>
</tr>
</tbody>
</table>
Welcome

The Epson® GT-15000 is a 48-bit color, large-format professional scanner that delivers superior results and versatility for business users. Using Epson’s ColorTrue® II Imaging System, the scanner captures text and images with amazingly accurate detail and color. Its 600 × 1200 dpi hardware resolution and 11.7 × 17-inch scan bed let you quickly capture incredibly sharp images from practically any size source document.

About Your Scanner

Your Epson GT-15000 scanner includes many advanced features:

- 48-bit color depth and 600 × 1200 optical resolution let you capture crisp, clean text and high-quality images with millions of colors and thousands of shades of gray.
- Scan through documents quickly, with accuracy and detail: letter-sized monochrome pages up to 16 ppm, color up to 10 ppm (landscape at 300 dpi, draft mode).
- Large scan bed and optional automatic document feeder let you quickly scan anything from a two-page book spread to a double-sided, 100-page document.
- Built-in USB and SCSI interfaces, optional Network Image Express card, or IEEE 1394 FireWire® interface card provide versatile connections for individual or workgroup users.
- Convenient Start button on the scanner lets you place your document and start your scan immediately. If the scanner is set up for network use, you can automatically send the image back to your workstation.
- EPSON Scan software provides automatic paper size detection. Includes additional software for document management, optical character recognition, and image editing.
About Your Software

The Scanner Software CD-ROM includes these software applications:

■ EPSON Scan
  General-purpose driver for scanning photographs, artwork, documents, or text for Optical Character Recognition (OCR). Includes automatic document size recognition and three modes for progressive levels of control over your scanned image.

■ Captiva® ISIS Driver
  The Image and Scanner Interface Specification (ISIS) is a flexible, modular standard for acquiring, viewing, converting, printing, and storing document images.

■ ABBYY FineReader® 5.0 Sprint
  A powerful, easy-to-use OCR program that lets you scan and send the text to a word processor or spreadsheet program. You can save scanned documents in RTF, TXT, or PDF format.

■ ScanSoft® PaperPort® Deluxe 9.0
  Use this leading document management software to scan your paper documents and then organize, file, edit, copy, fax, and e-mail them from one convenient screen.

Adobe® Photoshop® Elements 3.0 is provided on a separate CD-ROM. This State-of-the-art software lets you create high-quality images for print, e-mail, and the Web. It provides sophisticated, yet easy-to-use tools for correcting and enhancing digital images.

  Note: Adobe Photoshop Elements version 3.0 does not support Microsoft® Windows® 98 or Me. Windows 2000 is supported only for Service Pack 3 or later.
Getting More Information

There are several ways to learn more about your Epson GT-15000 scanner. In addition to this User’s Guide, here’s where to look for help:

- **Epson GT-15000 Reference Guide**  
  See the Reference Guide for complete instructions on using EPSON Scan, scanning in a network environment, and additional information about your scanner. The Reference Guide is installed on your desktop when you install the scanner software. To open it, double-click the GT-15000 Reference Guide icon on your desktop (or click Start > Programs or All Programs > EPSON > GT-15000 Guide > Reference Guide).

- **On-Screen Help**  
  For more information about any of the software that came with your scanner, click the Help button or access the Help menu.

- **Electronic Documents**  
  FineReader Sprint, PaperPort Deluxe, and Photoshop Elements all include electronic manuals in Adobe Acrobat® PDF format.

If none of these sources answers your questions, see “Where To Get Help” on page 64.

**Warnings, Cautions, Notes, and Tips**

Please follow these guidelines as you read this manual:

- **Warning:** Must be followed carefully to avoid bodily injury.
- **Caution:** Must be observed to avoid damage to your equipment.
- **Note:** Contains important information about your scanner.
- **Tip:** Contains hints for great scanning.
Chapter 1
Getting Started

This chapter describes the following procedures:

- Unpacking the scanner
- Turning the scanner on and off
- Connecting the scanner to your computer
- Installing the software

Unpacking the Scanner

Remove the scanner from the box and make sure you have these items:

- Scanner
- Power cord
- USB cable
- Scanner Software CD-ROM
- Adobe Photoshop Elements CD-ROM

Remove all the tape and packing material from the scanner. Save the packaging in case you need it for transporting the scanner.

Warning: The scanner is large and heavy. You might need to have someone help you unpack and lift it.
Choosing a Good Place for the Scanner

When deciding where to place the scanner, follow these guidelines:

■ Place the scanner on a flat, stable surface. If the scanner is tilted, it can’t operate properly.

■ Be sure to place the scanner where you can easily unplug the power cord, near a grounded wall outlet, and where the interface cable can reach your computer.

■ Keep the scanner away from direct sunlight and strong light sources.

■ Avoid places subject to shocks and vibrations, or high or rapidly changing temperatures and humidity.

■ Make sure there’s enough room behind the scanner for the cables, and above the scanner so you can fully raise the document cover.
Turning the Scanner On and Off

Follow these steps to turn on the scanner:

1. Pull up the transportation lock on the back of the scanner to the Unlock position.

2. Before you plug in the scanner, make sure it is turned off (the Power button is not pushed in).

3. Plug one end of the scanner’s power cord into the AC inlet at the back of the scanner, and the other end into a grounded electrical outlet.

4. Press the Power button on the front of the scanner to turn it on.

   The green Ready light starts flashing.

5. Wait until the Ready light stops flashing, then press the Power button again to turn it off.

Now see the next section to connect the scanner to your computer, and then install the software as described on page 16.
Connecting the Scanner to Your Computer

Follow the appropriate instructions below to connect the scanner to your computer’s USB or SCSI interface.

Note: You can also install optional interface cards in the scanner and use these for connecting to your computer system. For information about installing and using the optional IEEE 1394 (FireWire) card or Epson Network Image Express card, see Chapter 3, “Using Optional Equipment”.

**Connecting to a USB Interface**

1. Make sure the scanner is off.

2. Plug the flat end of the USB cable into any available USB port on your computer or powered USB hub. Plug the square end into the scanner’s USB port.

Note: Your scanner may not work correctly if you use a USB cable other than the one supplied by Epson, or if you connect your scanner to a multi-level USB hub system.
Connecting the Scanner to a SCSI Interface

In order to use the SCSI connection, you need to make sure your computer has a SCSI board and any necessary SCSI software installed. Then follow these steps to connect the scanner:

1. Make sure the scanner is off.

2. If you have another SCSI device that uses SCSI ID 2, turn the SCSI ID switch on the back of the scanner to a new number. Do not use 0, 1, or 7.

3. Unless your scanner is connected in the middle of a SCSI chain, leave the terminator switch on the back of the scanner turned On.

4. Squeeze the lock releases on your SCSI cable, and plug it into either SCSI connector on the back of the scanner. Connect the other end of the cable to the SCSI port on your computer.
Installing the Software

You must install the software to be able to use your scanner. Follow these steps:

1. Close all open programs and turn off any virus protection programs.
2. Make sure the scanner is OFF.

   **Note:** If you see a screen like either of the ones below, click Cancel and turn off the scanner. You can’t install your software that way.

3. Insert the Epson GT-15000 Software CD.
4. When you see the antivirus message, click Continue.
5. Read the Software License Agreement and click Agree. You see the installation screen:
6. Click **Install** and follow any instructions on the screen to install EPSON Scan and the other software applications. This will take a few minutes.

   If you have Windows XP, during the installation you’ll see a screen asking if you want to restart your computer. Select *No, I will restart my computer later* and click **Finish**.

7. When installation is complete, you see this screen:

![Congratulations! Installation is complete!](image)

   Follow the instructions in your User’s Guide to start scanning.

8. Click **Exit**.

9. Follow the instructions on the screen to register your scanner.

10. Press the **Power button** to turn on the scanner.

11. Remove the CD and restart your computer.

12. If you want to install Photoshop Elements, insert the Photoshop Elements CD-ROM after your computer restarts and follow the on-screen instructions.

   (You must have Windows XP or Windows 2000 Service Pack 3 or later to install and use the program.)

Now you are ready to scan. See page 19 for instructions.
Chapter 2
How To Scan

The EPSON Scan software included with your Epson GT-15000 provides three modes to give you progressive levels of control over the scanning process:

- **Home Mode:** Makes scanning quick and easy. It includes a simple interface, automatic image adjustments, and preset configurations for various types of scans.

- **Office Mode:** Includes a basic interface with practical scan settings designed for documents. Choose this mode to scan multi-page documents on the optional automatic document feeder.

- **Professional Mode:** Lets you manually configure advanced image settings, including the histogram setting, tone, color depth, balance, saturation, brightness, and contrast.

You can use EPSON Scan either in a “standalone” mode, or by starting from another program, such as PaperPort Deluxe or Photoshop Elements.

This chapter provides step-by-step instructions for the following:

- Placing your original document on the scanner
- Scanning to a file with EPSON Scan
- Scanning documents with PaperPort Deluxe
- Scanning text for editing (OCR)
- Scanning photographs with Adobe Photoshop Elements
- Scanning with the Start button.
- Selecting the scanning area
- Scanning tips
Placing Your Original Document

This section explains how to position documents or photos on the document table for scanning.

**Note:** If you’re scanning a multi-page document using the optional automatic document feeder, see “Scanning With the Automatic Document Feeder” on page 45.

1. Raise the scanner cover and place your document face down in the upper left corner of the document table.

   You can scan several pages or photos at the same time. Make sure you leave about an inch of space between them on the document table.

2. Close the document cover slowly. Be careful not to move the document.

   **Tip:** If the edges of your document don’t scan properly, move it in one-quarter inch from the edges of the document table.

   You can remove the document cover if you need to scan a thick item—such as a book—that doesn’t fit under the cover. Simply open the cover all the way and pull it straight up. When you reattach the cover, line the rods up with the positioning holes and lower the cover into place.

   **Warning:** Before removing the document cover, make sure you raise it all the way up. This will prevent the hinges from snapping back on the springs and possibly injuring you.
Scanning to a File With EPSON Scan

You can use the import or acquire function of a TWAIN-compliant application such as PaperPort Deluxe or Adobe Photoshop to scan images directly into your application, as described later in this chapter. Or you can scan directly to your computer by starting EPSON Scan from your desktop or from the Windows Start menu.

First, place your document or photo on the scanner as described on page 20. Then follow these steps:

1. Double-click the EPSON Scan icon on your desktop, or click Start > Programs or All Programs > EPSON Scan > EPSON Scan.

   **Note:** If you have multiple scanners installed, you are prompted to choose your scanner. Click EPSON GT-15000 and click OK.

2. Choose a mode from the Mode list at the top of the EPSON Scan window. (See page 19 for descriptions of the three modes.)

3. Continue with the instructions for your mode:
   - Home Mode on page 22
   - Office Mode on page 24
   - Professional Mode on page 26

4. After you finish selecting the settings for the mode you’ve chosen, click Scan. You see the File Save Settings window:

5. Click Browse if you want to select a different folder to store the file in. Then type a name for the file in the Prefix field, choose an image type, and click OK. (For more details, see the EPSON Scan on-screen Help.)
**Basic Scanning in Home Mode**

After you start EPSON Scan and choose **Home Mode**, you see this window:

Follow these steps to select your scan settings:

1. Click **Preview** to see a preview of your scan.
2. Click the **Auto Detect** button in the preview window to automatically select your entire document, or click and drag in the preview window to create a scanning selection area (marquee). For more information on using marquees, see page 37.

3. Choose a **Document Type** setting in the EPSON Scan window that is appropriate for your scan.

4. Choose an **Image Type** setting:
   - **Color** for color scans
   - **Grayscale** for scans of black-and-white photos or images
   - **Black&White** for text or line art

5. Choose a **Destination** setting. If you want to specify a size or resolution, click **Other** and choose a resolution setting (50 to 4800 dpi) or target size.

6. Select **Descreening Filter** to reduce moiré patterns in the image.

7. Select **Color Restoration** to automatically restore color in faded photos.

8. Click **Brightness** to open the Brightness and Contrast settings and adjust them as desired.

9. Click **Scan**, then see step 5 on page 21 for instructions on saving your scanned image.
**Scanning in Office Mode**

After you start EPSON Scan and choose **Office Mode**, you see this window:

Follow these steps to select your scan settings:

1. Click **Preview** to see a preview of your scan.
2. Click the Auto Detect button in the preview window to automatically select your entire document, or click and drag in the preview window to create a scanning selection area (marquee). For more information on using marquees, see page 37.

3. Make any of these adjustments in the EPSON Scan window, as necessary:
   - Select the appropriate Image Type: Color, Grayscale, or Black&White.
   - In the Destination box, you can change the Document Source (to ADF for example), Size, Orientation, or Resolution (50 to 1200 dpi).
   - Adjust the Brightness and Contrast settings for your image.
   - If you’re scanning printed materials, select Descreening Filter to reduce moiré patterns in the image.
   - To sharpen the image, select Unsharp Mask Filter.

4. Click Scan, then see step 5 on page 21 for instructions on saving your scanned image.
Advanced Scanning in Professional Mode

After you start EPSON Scan and choose Professional Mode, you see this window:

1. Click Preview to see a preview of your scan.

2. Click the Auto Detect button in the preview window to automatically select your entire document, or click and drag in the preview window to create a scanning selection area (marquee). For more information on using marquees, see page 37.

3. In the EPSON Scan window, choose the Auto Exposure Type: Photo to optimize exposure for photos, or Document to optimize exposure for printed material.

4. Either click Scan to complete your scan, or continue with the instructions in the next section to fine-tune it.
Customizing Your Scan

Follow these steps to use advanced settings:

1. Choose a color depth setting from the Image Type menu:
   - 24-bit Color for the highest quality color scans
   - Color Smoothing for color documents without photographs
   - 8-bit Grayscale for the highest quality scans of black-and-white photos or images
   - Halftone if you want to select special halftone patterns
   - Black&White for text or line art

2. Click to see more options, then choose Best or Draft for the Scanning Quality setting.

3. Choose a resolution setting (50 to 9600 dpi).

4. If you want to specify a Target Size for your scanned image other than the original size, select a size from the pull-down menu. You can also click to see more options, then type in the width and height, or scale the image with a percentage. If Trimming is set to On, your image is cropped to fit your specified size. If it is Off, your image is sized to fit your specified size as closely as possible.

5. Use the Adjustment settings to modify your image as necessary. (You may have to use the scroll bar to see these options.)
   - Auto Adjust – When Auto Adjust is on (the default), your software detects and analyzes the image with the document settings you’ve specified to determine the optimum settings for your scan. Click the button to turn it off.
   - Histogram Adjustment – Click this button to adjust the highlight, shadow, and gamma input levels.
   - Tone Correction – Click this button to choose a preset tone curve for specific effects or to change the tone curve manually.
   - Image Adjustment – Click this button to adjust the color balance, saturation, brightness, and contrast settings.
For any of the setting windows above, you can click Reset to go back to the default settings for your image. See the EPSON Scan on-screen help for more information about the Adjustment options.

6. The Unsharp Mask Filter option sharpens the image, and is on by default. You can Click to see more options, then choose a Level to reduce or increase the effect. To turn it off, click on the checkbox to remove the check mark.

7. Select the Descreening Filter option to reduce moiré patterns in the image.

   To specify the source image you are scanning, click to see more options, then choose the closest option to your source document in the Screen Ruling menu. (You may need to use the scroll bar to see this menu.)

8. For faded photographs, you can select Color Restoration to restore the colors.

9. Click Scan, then see step 5 on page 21 for instructions on saving your scanned image.

---

**Scanning Documents With PaperPort Deluxe**

The PaperPort Deluxe software included with your scanner lets you scan and manage a variety of documents. You can use PaperPort to file and organize documents on your computer just as you would handle paper documents, with the added convenience of searching by content as well as title.

First, place your document or documents on the scanner as described on page 20. Then follow these steps to scan with PaperPort Deluxe:

1. To start PaperPort, click Start > Programs or All Programs > ScanSoft PaperPort 9.0 > PaperPort.
You see the PaperPort desktop, with several sample documents and images:

2. Click the **Scan** button.

   You see these settings on the left side of the screen:

3. Select **EPSON GT-15000** and **Document**. Make sure you don’t select **WIA-EPSON GT-15000**.

4. Click the **Scan** button. EPSON Scan opens.

5. Choose **Office Mode** from the Mode list at the top of the EPSON Scan window. If you see a warning message about closing the preview window, click **OK**.
You see the EPSON Scan Office Mode settings:

6. Choose an Image Type:
   ■ Color for documents with color
   ■ Grayscale for documents with grayscale images or black and white photos
   ■ Black&White for plain text documents

7. Click Preview.

8. Click the Auto Detect button in the preview window to automatically select your entire document, or click and drag in the preview window to create a scanning selection area (marquee). For more information on using marquees, see page 37.

9. Make any of these adjustments, as necessary:
   ■ Select a resolution.
   ■ Adjust the Brightness and Contrast settings for your image.
   ■ If you're scanning printed materials, select Descreening Filter to reduce the moiré patterns in the image.
   ■ To sharpen the image, select Unsharp Mask Filter.

10. Click the Scan button.

   Your document is scanned, then displayed on the PaperPort desktop. You can file it, send it to an application, email it, or work with it in PaperPort.

   For more information, see the PaperPort Help or User's Guide (on the PaperPort Help menu).
Scanning Text for Editing

The ABBYY FineReader Sprint software included with your scanner lets you convert almost any printed document to text you can edit. Place your document(s) on the scanner as described on page 20. Then follow these steps to scan text for editing:

1. To start ABBYY FineReader, click Start > Programs or All Programs > ABBYY FineReader 5.0 Sprint. You see the program window with menus and buttons at the top.

2. Click the Scan&Read button. EPSON Scan opens.

3. Choose Office Mode from the Mode list at the top of the EPSON Scan window. You see the EPSON Scan Office Mode settings:

4. For most text scanning, choose Black&White and use the default settings, as shown.

5. Click the Scan button. Your document is scanned and opens in the ABBYY FineReader window.

6. Click the Save button. You see a standard Windows file save window. Choose a location, file name, and one of the following file types:

   - rtf: for editing in Microsoft Word®
   - pdf: for a “portable document file” that you can use in Adobe Acrobat.
   - txt: for an unformatted text file that you can open in many different programs.
You can also click the down arrow next to the Save button and choose to send the text to Microsoft Word or Excel® or Adobe Acrobat.

For more information about ABBYY FineReader, open the Help menu at the top of the screen or click Start > Programs or All Programs > ABBYY FineReader Tools > ABBYY FineReader 5.0 Sprint User’s Guide.

---

**Scanning Photographs With Adobe Photoshop Elements**

Adobe Photoshop Elements provides a variety of powerful tools for image editing, along with recipes and step-by-step instructions for using the tools. First, place your photo or photos on the scanner as described on page 20. Then follow these steps to scan photos with Photoshop Elements:

1. Double-click the Adobe Photoshop Elements 3.0 icon on your desktop. You see the Photoshop Elements window:
2. Click Start From Scratch.

3. Select Import from the File menu and then select EPSON GT-15000. EPSON Scan opens:

![EPSON Scan window]

4. Choose the Home Mode from the Mode list at the top of the EPSON Scan window. (If you want to use the Professional Mode, see page 26.)

5. Click the Preview button to see a preview of your scan.

6. Click the Auto Detect button in the preview window to automatically select your entire image, or click and drag to create a scanning selection area (marquee). For more information on using marquees, see page 37.

   **Note:** If the scanned image in the preview window has a blue box around it, you’re previewing in thumbnail mode. This allows you to scan multiple photos and automatically select them. If you want to select part of an image, click the arrow beside the Preview button in the EPSON Scan dialog box and select Normal from the pull-down menu. Then click the Preview button to preview in normal mode.
7. In the EPSON Scan window, choose **Photograph** in the Document Type list.

8. Choose **Color**, **Grayscale**, or **Black&White** for the Image Type.

9. Choose a Destination setting:
   - **Screen/Web** if you will only view your image on the screen
   - **Printer** if you’re printing the image
   - **Other** if you want to specify a resolution

10. Select a Target Size if you want to specify any size other than that of the original document.

11. Select the **Descreening Filter** option to reduce moiré patterns in the image.

   To specify the source image you are scanning, click  to see more options, then choose the closest option to your source document in the Screen Ruling menu. (You may have to use the scroll bar to see this menu.)

12. For faded photographs, you can select **Color Restoration** to improve the colors.

13. Click the **Brightness** button to adjust the Brightness and Contrast settings, if necessary.

14. Click **Scan**. If you are scanning multiple photos, each one is scanned individually.

15. Click **Close** to exit EPSON Scan and work with your image(s) in Photoshop Elements.

For more information about using Photoshop Elements, click the Help menu at the top of the screen, or see the *Getting Started Guide.pdf* in the \Program Files\ Photoshop Elements folder.
Scanning With the Start Button

You can use the Start button on your scanner to open EPSON Scan, and then scan your document as described below. Or, you can set up the Start button to open any compatible program on your computer and start scanning.

If you have set up the scanner on a network, you can use the Start button to scan automatically and send the document to an individual computer. For instructions on network scanning, see your on-screen Reference Guide.

First, place your document or photo on the scanner as described on page 20. Then follow these steps to use the Start button:

1. Press the Start button.

   If you’re using Windows 98, Me, or 2000, EPSON Scan opens and you’re ready to scan. If you want to have a different application open, see the instructions on the next page.

   If you’re using Windows XP, you see this window:

2. Select the program you want to use.

   To have the program open automatically whenever you press the Start button, check Always use this program for this action.

3. Click OK.

   **Note**: If you want to change the program after you set up the Start button, do the following. Open the Scanners and Cameras utility in the Windows Control Panel, right-click EPSON GT-15000 and select Properties. Click the Events tab and choose the Start Button. Under Actions, select the program you want the Start button to start.
Setting Up the Start Button in Windows 98, Me, or 2000

EPSON Scan opens by default when you press the  
Start button. If you want to have a scanning application open instead, follow these steps:

1. Click Start > Settings > Control Panel.
2. Double-click the Scanners and Cameras icon.
3. If you’re using Windows 98 or 2000, select your scanner from the list of devices and click Properties.
   If you’re using Windows Me, right-click the EPSON GT-15000 icon and select Properties.
4. Select the Events tab. You see a window like the one on the right:
5. Make sure  Start Button is selected under Scanner events.
6. Click the checkbox for the application you want the  
Start button to open. Make sure you clear the checkboxes for all the other applications.
   If you want to choose from a list when you press the  
Start button, you can select multiple applications.
7. Click Apply, then click OK.
Selecting the Scanning Area in the Preview Window

The preview window lets you select the area of your image that you want to scan with a marquee (a frame that you draw around the previewed image). You can create up to 50 marquees at one time. The currently selected marquee has a moving, dotted line. EPSON Scan adjusts the image quality settings to optimize each selected area.

- To automatically create a marquee around the entire image (and cut out the document table area) click the Auto Detect button.
- To select the area to scan, click and drag in the preview window. A marquee appears around the selection.
- To move the marquee, move the cursor to its center. When the cursor turns into a hand symbol, click and drag the marquee to a new position.
■ To resize the marquee, move the cursor to an edge or corner of the dotted line. When the cursor turns into an arrow symbol, click and drag to resize the selection area.

■ To zoom to the selected area, click the Zoom button. If you have multiple marquees, the currently selected one appears in the Zoom preview.

■ To erase a marquee, click the marquee and click the Delete button.

■ To create multiple marquees of the same dimensions, select one marquee, then click the Duplicate button.

■ To scan all selected areas at once, click the All button.

---

**Scanning Tips**

Getting the best scan possible depends on several factors, including the quality of your original and the resolution you select. The better your original is, the better your scan will be. To get the best possible scan, keep the document table clean, and make sure the document is flat against the glass surface. You can make many corrections in your scanning software. For additional photo retouching, use an image editing program such as Adobe Photoshop Elements.

**Selecting Resolution**

Resolution refers to how many dots per inch (dpi) or dots per centimeter (dpcm) your image contains. The best resolution for a scanned image depends on the type of image you’re scanning and your final output device.

If you want to print the image in its original size (1:1 ratio), scan it at 300 dpi. To enlarge photographs or scan documents for your OCR software application, select a resolution of 400 to 600 dpi. If you’re scanning an image to view on-screen, choose 96 dpi.
Follow the guidelines in this table for selecting a resolution:

<table>
<thead>
<tr>
<th>Type of scan</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photograph</td>
<td>300 dpi</td>
</tr>
<tr>
<td>Text with images</td>
<td>400 dpi</td>
</tr>
<tr>
<td>Line art</td>
<td>300 to 1200 dpi</td>
</tr>
<tr>
<td>Image for web</td>
<td>96 to 150 dpi</td>
</tr>
<tr>
<td>Text for OCR</td>
<td>400 dpi</td>
</tr>
<tr>
<td>Newspaper</td>
<td>400 dpi</td>
</tr>
<tr>
<td>Magazine</td>
<td>300 dpi</td>
</tr>
</tbody>
</table>

**Scaling (Resizing) Images**

If you plan to enlarge your image, it’s better to enlarge it by scanning at a higher resolution. If you change the image resolution or size in an application, you lose image quality. Keep this in mind when scanning small photos that you plan to enlarge.

**Scanning Color Images**

If the colors in your scanned image don’t match those in your original document, try experimenting with the Document Type/Image Type settings and Image Adjustment settings to adjust the colors. Also, try selecting just the area that you want to scan with a marquee (see page 37). This will let the scanner software choose the optimum color and exposure settings for that part of the image. If there is a border around your image or if the document cover is in the scanning area, this may adjust the exposure and colors in your scan.
Chapter 3
Using Optional Equipment

Three options are available for the Epson GT-15000:

- Automatic document feeder (B813212)
- Epson IEEE 1394 FireWire scanner interface card (B808342)
- Epson Network Image Express scanner interface card (B12B808393)

You can purchase these accessories from an authorized Epson reseller. To find the nearest reseller, call 800-GO-EPSON (800-463-7766). You can also purchase online at www.epsonstore.com (U.S. sales) or www.epson.ca (Canada sales).

Follow the instructions in this chapter to:

- Unpack and install the automatic document feeder
- Scan with the automatic document feeder
- Fix jams in the automatic document feeder
- Install the IEEE 1394 FireWire scanner interface card
- Install the Network Image Express card
Using Optional Equipment

Automatic Document Feeder

The automatic document feeder (B813212) allows you to load and scan multiple-page documents. You can scan up to 100 sheets at a time, either one-sided or two-sided.

When you unpack the automatic document feeder, make sure you have the parts shown below. If any items are missing or damaged, contact your Epson dealer, or call Epson at (562) 276-4382 (in the United States) or (905) 709-3839 (in Canada).

**Warning:** The automatic document feeder is large and heavy. You’ll need to have someone help you unpack it and set it up.

**Note:** Although the automatic document feeder comes with four feet, you need only the two smaller ones to connect it to the scanner. (The other feet are for another scanner model.)
Installing the Automatic Document Feeder

1. Make sure your scanner is turned off and the power cord is unplugged.

2. Open the document cover, then grasp the back of the cover and lift it off the scanner.

   **Warning:** Before removing the document cover, make sure you raise it all the way up. This will prevent the hinges from snapping back on the springs and possibly injuring you.

3. Make sure the document table is clean and free of dust.

4. Attach the two smaller feet to the automatic document feeder, as shown on the right:

5. Insert the two installation screws into the holes on the back of the scanner, then tighten the screws with the screwdriver that came with the automatic document feeder.
6. Align the screws with the holes in the automatic document feeder. Then slide the holes over the installation screws. Make sure the small pegs below the holes on the feeder go all the way into the back of the scanner.

**Warning:** Have someone help you lift the automatic document feeder.

7. Secure the knobs to the ends of the installation screws using the screwdriver.

Make sure the base of the feeder is flush against the back of the scanner.

8. Attach the cable to the scanner’s **ADF** connector and tighten the screws.
9. Make sure the switch on the underside of the feeder is set towards the circle, as shown. Then lower the automatic document feeder.

10. Once the automatic document feeder is attached, you can plug in the scanner’s power cord, connect the cable, and turn on the scanner.

    **Note:** If you’re using the SCSI connection, you need to restart your computer after plugging in the feeder.

---

### Scanning With the Automatic Document Feeder

Your automatic document feeder can hold up to 100 pages at a time. You can load letter-size or smaller pages in either landscape or portrait orientation. You can load larger pages in the portrait orientation only.

Follow these guidelines when scanning with the automatic document feeder:

- Make sure the ink on the document is dry.
- Make sure the document has no holes, cut-outs, wrinkles, tears, carbon coating, staples, or other attachments.
- Make sure the document is not folded near the edges and is not a multi-part form.
- Do not place photos or valuable original artwork in the feeder. These should be scanned individually on the document table.
Follow these steps to scan:

1. Slide the edge guide all the way out.

2. Insert your document face up in the feeder, bottom edge first, until it meets resistance.
   
   **Note:** Don’t push the document into the feed path or the pages may jam.

3. Move the edge guide so it touches the edge of your paper.

4. Scan your document. Follow these guidelines to use EPSON Scan:
   
   - Select the **Office Mode** from the Mode list.
   - Select **ADF-Single-sided** or **ADF-Double-sided** as the Document Source.
   - If you want to scan only part of the document page, load the first page only.

   Click the **Preview** button. The first page is ejected. Adjust the marquee in the Preview area, then load your entire document. When you click **Scan**, the scanner scans the area defined by the marquee on each page.
Note: You can still scan individual pages, if you want. Just lift the automatic document feeder and place your document face down on the document table. Select Document Table as the Document Source in EPSON Scan. Be sure to close the automatic document feeder before scanning. If you open it while scanning, you’ll get an error.

**Fixing Document Jams**

If a document gets jammed in the feeder, follow these steps to clear it:

1. Lift up the feeder and determine where the jam occurred.

2. If the jam is on the left, open the left cover. If the jam is on the right, open the right cover. Slowly pull the jammed pages out of the feeder mechanism. Be careful not to tear the paper.

   ![Left jam](image)
   ![Right jam](image)

   If a page tears, open the middle cover and remove it as shown:

3. After removing the jammed pages, close the covers and lower the feeder. Make sure the red Error light is off and the green Ready light isn’t flashing before trying to scan.

   ![Middle cover](image)
4. If the error isn’t cleared, turn your scanner off and then on again. Also, close EPSON Scan. Don’t restart EPSON Scan until the green Ready light stops flashing.

Note: If you attempt to preview or scan before the scanner is ready, EPSON Scan may stop responding. If this happens, restart your computer.

Installing the IEEE 1394 FireWire Scanner Interface Card

The IEEE 1394 FireWire scanner interface card (B808342) offers high-speed image transfer and flexible connectivity for your scanner. It supports a peak data transfer rate of 400 Mbps, and allows you to connect multiple IEEE 1394 devices. The card and included cable are shown on the right:

To use the IEEE 1394 FireWire interface card, your system must have the following:

- Built-in IEEE 1394 FireWire port or IEEE 1394 FireWire PCI card (OHCI-compliant)
- Pre-installed version of Windows XP, 2000 Professional, or Me

Follow these steps to install the IEEE 1394 FireWire card in your scanner and connect it to your computer:

1. Turn off the scanner and disconnect the power cord and any cables.

Caution: Static electricity can damage electronic components like the IEEE 1394 FireWire scanner interface card. To discharge static electricity, touch the scanner’s metal frame before handling the card.
2. Remove the two screws securing the shield plate to the scanner’s optional interface slot. Then remove the plate.

Put the screws and shield plate in a safe place in case you want to reinstall the shield plate later.

3. Turn the card over so that the component side is facing down, and insert it in the optional interface slot.

4. Push gently until the card is firmly seated.

5. Tighten the retaining screws and reconnect the scanner’s cables.

6. Plug one end of the IEEE 1394 cable into the IEEE 1394 port on the card, and the other end into an IEEE 1394 (FireWire) port on your computer.
Installing the Network Image Express Card

The Network Image Express card (B12B808393) allows you to share your scanner without the need for a server. The card supports 10BaseT/100BaseT full and half duplex networks.

Any computer on the network that has the EPSON Scan software installed can scan and import a document from the Epson GT-15000.

For information on setting up and using the scanner on a network, see your on-screen Epson GT-15000 Reference Guide.

Follow these steps to install the card in your scanner and connect it to your network:

1. Turn off the scanner and disconnect the power cord and any cables.

   **Caution:** Static electricity can damage electronic components like the Network Image Express card. To discharge static electricity, touch the scanner’s metal frame before handling the card.

2. Remove the two screws securing the shield plate to the optional interface slot. Then remove the plate.

   Put the screws and shield plate in a safe place in case you want to reinstall the shield plate later.

3. Turn the card over so that the component side is facing down, and insert it in the optional interface slot.

4. Push gently until the card is firmly seated.

5. Tighten the retaining screws and plug in the scanner.
6. To initialize the card, turn on the scanner while holding down the Reset button on the card for about 10 seconds. The red and green lights on the card turn on.

7. Wait until the red and green lights turn off, then turn off the scanner.

8. Connect an Ethernet cable to the connector on the card. Make sure you use a Category 5 shielded twisted-pair cable.

9. Connect the other end of the cable to your network hub.

For information on configuring the scanner for your network, see the *Epson Network Image Express Card User’s Guide* that came with the card.
Chapter 2
Maintenance

To protect your scanner and ensure optimum performance, follow the instructions in this chapter to clean and transport the scanner.

Cleaning the Scanner

1. Press the Power button to turn the scanner off, and unplug the power cord.
2. Use a soft, damp cloth and mild detergent to clean the outer case.
3. Clean dust and smudges from the document table glass with a soft, dry cloth (a microfiber glass cleaning cloth is recommended). You can also use compressed air dust remover sprays. Dust on the glass can cause white spots to appear in your scanned image.

To remove grease, use pretreated lens/scanner wipes.

Caution: Always unplug the scanner before cleaning.

Don’t let water or any other liquid get into the scanner mechanism or electronic components. This could permanently damage them.

Never use a harsh or abrasive brush or cleaning product to clean the document table. A damaged glass surface can decrease the scanning quality.

Never use alcohol, thinner, or corrosive solvent to clean the scanner. These chemicals can damage the scanner components as well as the case.

Don’t spray lubricants inside the scanner and be careful not to spill liquid into the scanner mechanism or electronic components. This could permanently damage them.

Never open the scanner case. If you think repairs or adjustments are necessary, consult your dealer or contact Epson.

Unplug the scanner and refer servicing to qualified service personnel if the power cord or plug is damaged, if liquid has entered the scanner, if the scanner has been dropped or the case damaged, or if the scanner does not operate normally or exhibits a distinct change in performance.
Transporting the Scanner

Always secure the carriage when you transport the scanner a long distance or store it for an extended time.

1. If you’re using the automatic document feeder, remove it from the scanner and replace the scanner cover.

   **Warning:** Make sure you have someone help you lift the automatic document feeder.

2. Turn on the scanner and wait until the carriage moves left to the home position. Then turn off the scanner.

3. Push down the transportation lock at the back of the scanner to the Lock position.

4. Use the scanner’s original box, or a similar box with enough packaging material to prevent movement inside the box.

5. Pack the automatic document feeder in its original box, or use a similar box with enough packaging material to prevent any movement inside the box.
Chapter 5
Solving Problems

This chapter explains how to interpret the signals from your scanner’s lights, and gives you basic steps for diagnosing and solving scanner problems. It also tells you how to uninstall your software and how to contact Epson.

See “Diagnosing Scanner Problems” in the next section to determine what the cause of your scanner problem might be. Then see these sections for solutions:

■ Scanner Problems
■ Software Problems
■ Quality Problems
■ Uninstalling and Reinstalling EPSON Scan
■ Where To Get Help

Tip: It’s a good idea to check Epson’s support web site periodically for possible updates to your scanner software. Visit http://support.epson.com and check to see if there is new software available, free of charge, for downloading to your computer. Download instructions are posted for your convenience.
Diagnosing Scanner Problems

You can diagnose some problems by checking the scanner’s lights, as described in this section. If you don’t find the answer here, see “Problems and Solutions” on page 57.

<table>
<thead>
<tr>
<th>Light</th>
<th>Scanner Status</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ready</strong> light is on or flashing.</td>
<td>The green <strong>Ready</strong> light is on when the scanner is ready to scan. It flashes when scanning is in progress.</td>
</tr>
<tr>
<td><strong>Error</strong> light is flashing; <strong>Ready</strong> light is off.</td>
<td>There’s a problem with your cable connection. Reconnect the cable to both the scanner and your computer, and then restart your computer. If this doesn’t work, try using a different cable. If you have a USB connection, use the USB cable that came with your scanner. If you have a SCSI connection, always restart your computer after changing or reconnecting the cable.</td>
</tr>
<tr>
<td><strong>Error</strong> and <strong>Ready</strong> lights are both on.</td>
<td>The scanner has received an incorrect command from your scanning software. Try scanning again.</td>
</tr>
<tr>
<td><strong>Error</strong> and <strong>Ready</strong> lights are both off.</td>
<td>Make sure your scanner is connected to a working outlet, then press the <strong>Power button</strong>. Restart your computer. If the green <strong>Ready</strong> light doesn’t come on, there may be a problem with the automatic document feeder, or the cover may be open. Make sure the cover or automatic document feeder is closed. If you are using the feeder, make sure a document is loaded, and pages are not jammed.</td>
</tr>
<tr>
<td><strong>Error</strong> and <strong>Ready</strong> lights are both flashing.</td>
<td>Check that the transportation lock on the back of the scanner is set to <strong>Unlock</strong>. If not, unlock the scanner, then turn it off and back on again. Restart your computer. If this doesn’t solve the problem, contact Epson as described on page 64.</td>
</tr>
</tbody>
</table>
Problems and Solutions

Here are some troubleshooting tips if you’re having trouble setting up your scanner, scanning, or getting the quality you want from your scans.

**Scanner Problems**

**The Ready light doesn’t come on or flashes.**

- The Ready light flashes when scanning is in progress. If you are scanning a large file, wait for scanning to finish.
- Make sure the scanner power cord is securely plugged into the scanner and the power outlet, and that the scanner is turned on. If the scanner was unplugged or off, restart your computer before trying to scan.
- Check that the power outlet is working and provides sufficient power for the scanner.
- If you’re using the automatic document feeder and both the Ready and Error lights are off, make sure the feeder is closed. Turn off the scanner, then reconnect the feeder to the ADF connector on the back of the scanner. Turn the scanner back on and restart your computer.

- If you’re using the automatic document feeder, make sure a document is loaded, and pages are not jammed. If a jam occurs, remove the jammed pages as described on page 47.
- If you’re using the SCSI connection, make sure the SCSI ID is set between 2 and 6. If you reset the SCSI ID switch on the back of the scanner, turn the scanner off and then on again. Then restart your computer.

**You see an error message when you try to scan.**

- Make sure your scanner is turned on.
- Check your cable connections.
- If you have a USB connection, use the cable that came with the scanner. Try using a different USB port. If your scanner is connected to a USB hub, connect it directly to the computer’s USB port.
Check the Device Manager in the Windows Control Panel System utility. If you see a ! or ? mark, or the scanner appears as an Unknown Device, remove the scanner. Uninstall and reinstall EPSON Scan as described on page 64.

If you have a SCSI connection, turn off both your scanner and computer. Then turn on your scanner before you turn on the computer.

If you have a SCSI connection, make sure your SCSI board is installed correctly. Check the Device Manager in the Windows Control Panel to make sure the SCSI board is listed.

If the SCSI board is found but not the scanner, check the terminator switch and SCSI ID switch on the back of the scanner. Make sure the SCSI ID doesn’t conflict with another SCSI device. Unless the scanner is in the middle of a SCSI chain, the terminator switch should be set to ON.

If you’ve replaced your SCSI board or changed the SCSI ID, you may need to uninstall and reinstall your scanner software. See the instructions on page 64.

Check for IRQ conflicts with built-in options.

If you purchased the IEEE 1394 scanner interface card as an option, make sure that it is installed correctly. (See page 48.)

If you are using the scanner on a network, make sure your EPSON Scan settings are configured for network operation.

If all else fails, uninstall and reinstall your software as described on page 64.

If you are using the automatic document feeder, make sure the base of the feeder is flush against the back of the scanner.

The scanner doesn’t scan your image.

Make sure the scanner is ready to scan. Wait until the Ready light stops flashing and remains on.

If you attempt to preview or scan before the scanner is ready, EPSON Scan may stop responding. If this happens, restart your computer.

Make sure the scanner’s transportation lock is in the Unlock position.

Check the Device Manager in the Windows Control Panel System utility. If there is an Unknown Device icon, select it and click Remove.
■ If you’re using software like Adobe Photoshop Elements or PaperPort Deluxe, make sure you select EPSON GT-15000 as your scanner or import source.

■ Make sure the SCSI ID switch on the back of the scanner is not set to the asterisk (*), and that it’s set to a number that doesn’t conflict with any other SCSI devices. If you reset the SCSI ID switch, turn the scanner off and then on again. Then restart your computer.

■ Make sure you have enough memory to scan your image. If you’re scanning a large image or scanning at a high resolution, close any unnecessary programs. Try scanning at a lower resolution, or select part of the image to scan. If you still cannot scan, you may need to upgrade your RAM.

■ If you have a SCSI ZIP drive, it may be interfering with your scanner. Disconnect the ZIP drive, restart your computer, then try scanning again.

■ If you’re using the optional automatic document feeder, run EPSON Scan in Office Mode or Professional Mode, and select ADF-Single-sided or ADF-Double-sided as the Document Source. Also, make sure the original document is inserted face up.

When previewing a scan, you see a message that the document could not be located.

Make sure you’ve selected the correct Document Type in EPSON Scan.

You can’t scan multiple images.

■ Position photos or documents at least an inch apart.

■ Make sure the application you are using supports multiple image scanning.

Pages jam in the automatic document feeder.

Remove the jammed pages, following the instructions on page 47.

The scanner doesn’t start when you press the $ Start button.

Check the Events tab in the scanner’s properties window. Make sure Take no action or Disable device events are not selected.
Software Problems

EPSON Scan doesn’t work properly.

■ Make sure your system meets the minimum requirements. See the requirements on page 71.

■ Check your computer’s memory. If you’re running other software at the same time, have many device drivers, or you’re scanning a large image, the computer may not have enough memory. (See your software and computer manuals.)

■ Check your software installation. Make sure that your software is correctly installed and set up. If all else fails, uninstall your software, then reinstall it.

You can’t select ADF as the Document Source (Office Mode or Professional Mode).

■ Make sure the optional automatic document feeder is installed correctly and securely connected to the ADF connector on the back of the scanner. If you need to reinstall or reconnect it, restart your computer afterward.

■ Try turning the scanner off then back on.

You can’t open PaperPort Deluxe.

Restart Windows, then try opening PaperPort again.

Quality Problems

Your scanned image is faint or out of focus.

■ Decrease the brightness setting in EPSON Scan Office or Home Mode.

■ Select Professional Mode and adjust the exposure using the Auto Adjust button.

■ Select Professional Mode and adjust the Gamma setting using the Histogram Adjust button.

■ Check the condition of your original. If the document is damaged, dirty, or wrinkled, these imperfections will show up in your scan.

■ Make sure the document is placed flat against the document table.
Your scanned image is blurred or distorted.

- Check the position and condition of your document. Make sure it is placed flat against the document table glass. If only part of the image is blurred, part of your document may be wrinkled or warped.

- Make sure the document table glass is clean.

- Make sure you didn’t accidentally move the document during scanning.

- Make sure the scanner is on a flat, stable surface.

The edges of the document aren’t scanned.

- Don’t place your document right up against the edges of the document table. Move the document about a quarter of an inch away from the edges.

- If colors are patchy or distorted at the edges of the image, the document may be too thick, or there may be outside light interfering with the scan. If you are scanning without the cover, place paper over the edges of the document to block outside light.
Your image scans at an angle.
Check the position of your document. It may be placed at an angle on the document table. Align it so the horizontal and vertical edges are carefully aligned with the scales on the top and side of the document table.

Straight lines in the image come out jagged.
Make sure the document is aligned with the scales on the top and side of the document table.

Your image is too dark.
- Increase the brightness setting in EPSON Scan Office or Home Mode.
- Select Professional Mode and adjust the exposure using the Auto Adjust button.
- Select Professional Mode and adjust the Gamma setting using the Histogram Adjust button.
- Try different combinations of gamma and color settings in EPSON Scan. Click the Configuration button at the bottom of the window, then make any changes on the Color tab.
- Change the Destination setting in the Home or Office Mode.

A line of dots is missing from the image.
- When a line of dots is missing from the scanned image on your screen, the scanner sensor has malfunctioned. Contact Epson.
- When a line of dots is missing from your printouts, your printer has malfunctioned. See your printer manual.
The colors in your scanned image look different from the colors in the original document.

- Make sure the Image Type setting in EPSON Scan is correct.
- Try different combinations of gamma and color settings in EPSON Scan. Click the Configuration button at the bottom of the window, then make any changes on the Color tab.
- Exact color matching is difficult. Check your software and monitor documentation for information on color matching and calibration.

Moiré (cross-hatch) patterns appear in the scanned image.

- Make the image size slightly smaller.
- In EPSON Scan, select the Descreening Filter checkbox. If you’re using Professional Mode, you may have to scroll to see this setting.
- In Professional Mode, set the Screen Ruling to the appropriate setting for your document.
- Use a transparent sheet between the document and the document table to defocus the image slightly.
- Reposition the document on the document table. Try positioning the document at a slight angle.

The printed image is larger or smaller than the original.

You can’t judge the size of the printed image by what you see on your screen. The image size settings in your scanner software determine the size of the printed image. Check the Target Size setting in EPSON Scan.

The image doesn’t scan, or you get only a few dots for the scanned image.

- Make sure the document is face down on the document table.
- If you’re using the automatic document feeder, make sure the original document is inserted face up.
- Select Black&White for the Image Type and change the Threshold setting.

The file size is too big.

Adjust your scan settings. Try setting at a lower resolution (dpi), or scan only part of the image.

Poor character recognition during OCR scanning.

Adjust the Threshold setting.
Uninstalling and Reinstalling EPSON Scan

If you’ve tried every other solution and your system still doesn’t recognize your scanner, try uninstalling and reinstalling the scanner software.

1. Turn off the scanner and disconnect it from the computer.

2. Double-click the Add or Remove Programs icon in the Windows Control Panel.

3. Select EPSON Scan, and click the Change/Remove (or Add/Remove) button.

4. Follow the on-screen instructions to remove the software. If you see a message prompting you to restart the computer, select Yes, I want to restart my computer now, and click Finish.

Follow the instructions on page 16 to reinstall your software.

Where To Get Help

If you are having problems with EPSON Scan or your scanner, see the contact information in the section below. If you are having problems with your other software, see page 65.

Epson Technical Support

Epson provides these technical support services:

<table>
<thead>
<tr>
<th>Service</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internet support</td>
<td>Visit Epson’s support website at <a href="http://support.epson.com">http://support.epson.com</a> and select your product for solutions to common problems. You can download drivers and documentation, get FAQs and troubleshooting advice, or e-mail Epson with your questions.</td>
</tr>
<tr>
<td>Automated Telephone Support</td>
<td>Automated help services are available 24 hours a day, seven days a week. Using a touch tone telephone, call <a href="">800) 922-8911</a>. Enter your Epson SoundAdvice™ Express code—70505—to quickly select GT-15000 information.</td>
</tr>
</tbody>
</table>
**Speak to a Support Representative**

Before you call for support, please have the following information ready:

- Product name (Epson GT-15000)
- Product serial number (located on the back of scanner)
- Proof of purchase (such as a store receipt) and date of purchase
- Computer configuration
- Description of the problem

Then call:

- U.S.: (562) 276-4382, 6 AM to 6 PM, Pacific Time, Monday through Friday.
- Canada: (905) 709-3839, 6 AM to 6 PM, Pacific Time, Monday through Friday.

Toll or long distance charges may apply.

**Purchase Supplies and Accessories**

You can purchase accessories from an authorized Epson reseller. To find the nearest reseller, call 800-GO-EPSON (800-463-7766). Or you can purchase online at www.epsonstore.com (U.S. sales) or www.epson.ca (Canada sales).

**Other Software Technical Support**

<table>
<thead>
<tr>
<th>Software</th>
<th>Telephone</th>
<th>Fax</th>
<th>Online and E-mail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adobe Photoshop Elements</td>
<td>(206) 675-6358</td>
<td>—</td>
<td><a href="http://www.adobe.com/support/techdocs@adobe.com">www.adobe.com/support/techdocs@adobe.com</a></td>
</tr>
<tr>
<td></td>
<td>6:00 AM to 5:00 PM,</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pacific Time, Monday to</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Friday (pay support)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ABBYY FineReader Sprint</td>
<td>(510) 226-6719</td>
<td>(510) 226-6069</td>
<td><a href="http://www.abbyyusa.com/support@abbyyusa.com">www.abbyyusa.com/support@abbyyusa.com</a></td>
</tr>
<tr>
<td>ScanSoft PaperPort Deluxe</td>
<td>(978) 977-8430</td>
<td>—</td>
<td><a href="http://www.scansoft.com/paperport/support">www.scansoft.com/paperport/support</a></td>
</tr>
<tr>
<td></td>
<td>10:00 AM to 7:00 PM,</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Eastern Time, Monday to</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Friday (pay support)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Appendix A
Specifications

Scanner

General
Scanner type
Flatbed, color
Photoelectric device
Color Matrix CCD™ line sensor
Monochrome line sensor
Effective pixels
7020 × 10200 pixels (600 dpi)
Color depth
48-bit internal/24-bit external
Grayscale depth
16-bit internal/8-bit external
Maximum document size
11.7 × 17.0 inches (297 × 432 mm)
(the reading area can be specified from your software)
Resolution
600 dpi (optical)
Maximum hardware resolution*
600 dpi (main scan)
1200 dpi with Micro Step Drive™
(sub scan)
* The maximum hardware resolution of
600 × 1200 dpi is achieved using Epson’s
Micro Step Drive technology
Maximum interpolated resolution
4800 dpi

Speed (600 dpi, draft mode)
Color: 3.8 msec/line (approx.)
Grayscale: 1.3 msec/line (approx.)
Line art: 1.3 msec/line (approx.)

Color separation
RGB color filters on CCD

Reading sequence
Monochrome: One-pass scanning
Color byte sequence: One-pass scanning
(R, G, B)
Color line sequence: One-pass scanning
(R, G, B)

Zoom
50 to 200% in 1% increments

Command level
ESC/I-B7
FS

Pixel depth
16 bits per pixel input, 1 to 8 bits per pixel output

Brightness
7 levels

Line art settings
Fixed threshold
TET (Text Enhancement Technology, enable/disable selectable)
Digital halftoning
  AAS (Auto Area Segmentation, enable/disable selectable)
  3 error diffusion modes (A, B, and C)
  4 dither patterns (A, B, C, and D) for bi-level and quad-level data
  (2 downloadable dither patterns)

Gamma correction
  2 types for CRT display
  3 types for printer
  1 type user-defined

Color correction
  1 type for CRT display
  3 types for printer (available in color byte sequence mode and color line sequence mode)
  1 type user-defined

Interfaces
  SCSI 2 (half pitch 50-pin connectors)
  USB 2.0 (Type B receptacle connector)
  IEEE 1394 (FireWire), optional
  10Base-T/100Base-TX, optional

Light source
  Xenon gas cold cathode fluorescent lamp

Reliability
  100,000 cycles of carriage movement (main unit MCBF)

Dimensions
  Width: 25.8 inches (656 mm)
  Depth: 18.0 inches (458 mm)
  Height: 6.2 inches (158 mm)

Weight
  Approximately 29.8 lb (13.5 kg)

Rated frequency
  50 to 60 Hz

Rated current
  100 to 120 VAC: 0.8 A
  220 to 240 VAC: 0.3 A

Power consumption
  Operating: Approximately 50 W
  Standby: Approximately 7.5 W

Environmental

Temperature
  Operating: 41 to 95 °F (5 to 35 °C)
  Storage: –13 to 140 °F (–25 to 60 °C)

Humidity (without condensation)
  Operating: 10 to 80%
  Standby: 10 to 85%

Operating conditions
  Ordinary office or home conditions. Avoid dust, direct sunlight, and proximity to strong light sources.

Safety Approvals

120 V model
  Safety: UL 1950
  CSA C22.2 No. 950
  EN 60950
  EMC: FCC part 15
  subpart B class B
  CSA C108.8 class B
  EN 55022 (CISPR Pub 22) Class B
  AS/NZS 3548 class B

230 V model
  Safety: EN 60950
  EMC: EN 550022 class B,
  EN 61000-3-2, 3-3
**SCSI Interface**

**Interface type**
- ANSI X3’T9.2/375R Revision 10L (SCSI 2)

**Logic level**
- TTL-compatible

**ID setting**
- Selectable from 0 to 7

**Terminator**
- Internal terminator (enable/disable selectable)

**Connector type**
- Two half pitch 50-pin connectors

**USB Interface**

**Interface type**
- Universal Serial Bus Specification Revision 2.0

**Electrical standard**
- Full speed mode (12 Mb) and High speed mode of Universal (480 Mbps) Serial Bus Specification Revision 2.0

**Connector type**
- One receptacle (Type B)

**IEEE 1394 FireWire**

**Interface type**
- IEEE 1394-1995 compatible

**Data transfer method**
- Half-duplex Data/Strobe differential serial

**Synchronization method**
- Clock synchronization with DS-Link

**Encoding/decoding**
- DS-Link

**Logic level**
- 3.3 V

**Compatible connectors**
- IEEE 1394-1995 compatible

**Power class**
- Power class code 100
- No power supply from external sources
- Fitted with a repeat function with bus power

**Environmental**

**Temperature**
- Operating: 41 to 95 °F (5 to 35 °C)
- Standby: −13 to 140 °F (−25 to 60 °C)

**Humidity (without condensation)**
- Operating: 10 to 80%
- Standby: 10 to 85%

**ADF Connector**

**Interface type**
- For use with the optional automatic document feeder (B813212)

**Output voltage**
- 21.6 to 26.4 VDC
- 4.75 to 5.25 VDC

**Output current**
- 0.6 A (24 V)
- 0.3 A (5 V)
Initialization Methods

SCSI interface
- Hardware: Initialized when the scanner is turned on or the scanner receives a SCSI Reset signal from the SCSI interface.
- Software: Initialized when the software sends the Esc @ (initialize the scanner command), or the scanner receives a SCSI Bus Device message.

USB interface
- Hardware: Initialized when the scanner is turned on or the USB cable is plugged into the USB port on the scanner.
- Software: Initialized when the software sends the Esc @ command or the scanner receives a Bus Reset from the USB interface.

Automatic Document Feeder (B813212)

General
- Paper input/output: Load face up; eject face down
- Paper quantity: 100 pages (55 g/m² paper, maximum total thickness under 0.48 inches [12 mm])
- Reliability: 100,000 sheets (load/eject MCBF)

Dimensions
- Width: 23.8 inches (605 mm)
- Depth: 19.2 inches (488 mm)
- Height: 5.3 inches (134 mm)

Weight
- Approximately 28.7 lb (13 kg)

Electrical
- Input voltage: 22.8 to 25.2 VDC
- 4.75 to 5.25 VDC
- Input current: 24 V: 1.5 A
- 5 V: 0.4 A
Appendix B

Requirements and Notices

System Requirements

The minimum system requirements are listed below. For optimum performance, a faster processor and more memory are recommended. If you’re scanning high resolution images, you need more than the minimum available hard disk space.

**Note:** Color and tone reproduction are subject to the display capability of your computer system, including the video card, monitor, and software. See the documentation for these products for details.

- A Microsoft Windows-compatible PC with a Pentium®-equivalent processor, 233 MHz or faster recommended
- Preinstalled Windows 98, 2000, Me, or XP for USB connection; Windows 98, 2000 Professional, Me, or XP for SCSI connection
- SCSI, USB, or FireWire IEEE 1394 (Windows XP, Me, or 2000 only) port; FireWire card must be OHCI-compliant
- 128MB RAM (256MB RAM recommended for all systems)
- 300MB available hard disk space
- CD-ROM drive
- SVGA color monitor with 800 × 600 resolution
- 16-bit, 65K-color display adapter card (24-bit display adapter card with millions of colors recommended)
Important Safety Instructions

Read all of these instructions and save them for later reference. Follow all warnings and instructions marked on the scanner.

■ Unplug the scanner before cleaning. Clean with a damp cloth only. Don’t spill liquid on the scanner. Use a soft, dry cloth or a compressed air spray designed for cleaning electronic equipment to clean dust from the document table glass.

■ Do not place the scanner on an unstable surface or near a radiator or heat source.

■ Use only the power cord that comes with this product. This product’s power cord is for use with this product only. Use of another cord (or use of this cord with other equipment) may result in fire or electric shock.

■ Use only the type of power source indicated on the scanner’s label. Always supply power directly from a standard domestic electric outlet with the AC power cord that meets relevant local safety standards.

■ Connect all equipment to properly grounded power outlets. Avoid using outlets on the same circuit as photocopiers or air control systems that regularly switch on and off.

■ Do not let the power cord become damaged or frayed.

■ If you use an extension cord, make sure the total ampere rating of the devices plugged into the extension cord doesn’t exceed the cord’s ampere rating. Also, make sure the total ampere rating of all devices plugged into the wall outlet doesn’t exceed the wall outlet’s ampere rating.

■ Do not attempt to service the scanner yourself.

■ Unplug the scanner and refer servicing to qualified service personnel under the following conditions: if the power cord or plug is damaged; if liquid has entered the scanner; if the scanner has been dropped or the cabinet damaged; if the scanner does not operate normally or exhibits a distinct change in performance. Do not adjust controls that are not covered by the operating instructions.
FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures.

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

Warning

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification of this device and may cause interference levels which exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.
Declaration of Conformity

According to 47CFR, Part 2 and 15 for Class B Personal Computers and Peripherals; and/or CPU Boards and Power Supplies used with Class B Personal Computers:

We: Epson America, Inc.
Located at: MS 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806-2469
Telephone: (562) 290-5254

Declare under sole responsibility that the product identified herein complies with 47CFR Part 2 and 15 of the FCC rules as a Class B digital device. Each product marketed is identical to the representative unit tested and found to be compliant with the standards. Records maintained continue to reflect the equipment being produced can be expected to be within the variation accepted, due to quantity production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Trade Name: Epson
Type of Product: Image Scanner
Model: J151A
Product: Epson GT-15000

Warranty

Epson America, Inc. Limited Warranty

What Is Covered: Epson America, Inc., (“Epson”) warrants to the original retail purchaser of the Epson product enclosed with this limited warranty statement that the product, if purchased new and used in the United States or Canada, will be free from defects in workmanship and materials for a period of one (1) year from the date of original purchase. For warranty service, you must provide proof of the date of original purchase.

What Epson Will Do To Correct Problems: Should your Epson product prove defective during the warranty period, please bring the product securely packaged in its original container or an equivalent, along with proof of the date of original purchase, to your Epson Dealer or Epson Customer Care Center. You are responsible for all costs (shipping, insurance, travel time) in getting the product to the service location. Epson will, at its option, repair or replace on an exchange basis the defective product, without charge for parts or labor. When warranty service involves the exchange of the product or of a part, the item replaced becomes Epson property. The replacement product or part may be new or
refurbished to the Epson standard of quality, and at Epson’s option, the replacement may be another model of like kind and quality. Epson’s liability for replacement of the covered product will not exceed the original retail selling price of the covered product. Exchange or replacement products or parts assume the remaining warranty period of the product covered by this limited warranty.

What This Warranty Does Not Cover: This warranty does not apply to refurbished or reconditioned products. This warranty covers only normal use in the United States and Canada. This warranty does not cover damage to the Epson product caused by parts or supplies not manufactured, distributed, or certified by Epson. This warranty is not transferable. This warranty does not cover third party parts, components, or peripheral devices added to the Epson product after its shipment from Epson, e.g., dealer-added boards, chips or drives. Epson is not responsible for warranty service should the Epson label or logo or the rating label or serial number be removed or should the product fail to be properly maintained or fail to function properly as a result of misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters such as fire, flood, and lightning, improper electrical current, software problems, interaction with non-Epson products, or service other than by an Epson Authorized Servicer. If a claimed defect cannot be identified or reproduced in service, you will be held responsible for costs incurred.

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED ABOVE. UNLESS STATED HEREIN, ANY STATEMENTS OR REPRESENTATIONS MADE BY ANY OTHER PERSON OR FIRM ARE VOID. IN THE EVENT THE REMEDIES ABOVE FAIL, EPSON’S ENTIRE LIABILITY SHALL BE LIMITED TO A REFUND OF THE PRICE PAID FOR THE EPSON PRODUCT COVERED BY THIS LIMITED WARRANTY. EXCEPT AS PROVIDED IN THIS WRITTEN WARRANTY, NEITHER EPSON AMERICA, INC., NOR ITS AFFILIATES SHALL BE LIABLE FOR ANY LOSS, INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE OR INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH OF WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts and some jurisdictions do not allow certain exclusions or limitations on damages, so the above limitations and exclusions may not apply to you. This warranty gives you specific legal rights, and you may also have other rights which vary from jurisdiction to jurisdiction.

To find the Epson Authorized Reseller nearest you, visit our website at: http://www.epson.com.

To find the Epson Customer Care Center nearest you, visit http://support.epson.com.

You can also write to: Epson America, Inc., P.O. Box 93012, Long Beach, CA 90809-3012.
Index

A
ABBYY FineReader Sprint Plus, 8, 31 to 32, 65
Accessories, 41, 65
Adobe Photoshop Elements, 32, 65
Auto Adjust button, 27
Auto Detect button, 23, 25 to 26, 30, 33, 37
Auto Exposure Type setting, 26
Automatic document feeder
   Document Source setting, 46
double-sided scanning, 46
   fixing document jams, 47 to 48
   installing, 43 to 45
loading pages, 45
problems, 47 to 48, 56, 60
purchasing, 41, 65
specifications, 70
using, 45 to 47

B
Blurred image, 61
Brightness setting, 23, 25, 27, 30, 34, 60
Buttons, 56

C
Cleaning the scanner, 53
Color problems, 62 to 63
Color Restoration setting, 23, 28, 34
Connecting scanner, 14 to 15
Contrast setting, 23, 25, 27, 30, 34

D
Descreening Filter setting, 23, 25, 28, 30, 34
Destination setting, 34
Document jams, fixing, 47 to 48
Document position, 20, 61
Document Type setting, 34
Documentation, 9
Double-sided scanning, 46

E
Electrical requirements, 68
Environmental requirements, 68
Epson
   help, 64 to 65
   Store, 41, 65
EPSON Scan
   Home Mode, 19, 21 to 23, 33 to 34
      installing, 16 to 17
   Office Mode, 19, 24 to 25, 29 to 30
      previewing scans, 37 to 38, 59
      problems, 60
   Professional Mode, 19, 21, 26 to 28
      scanning to a file, 21
      starting, 21
Error light, 56
Ethernet card, 50 to 51

F
Faint image, 60
FCC compliance statement, 73
File Save Settings, 21
File size, 63
FineReader Sprint, 8, 31 to 32, 65
FireWire
  installing the scanner card, 48 to 49
  scanner card specifications, 69
  system requirements, 48

G
  Gamma adjustment, 27, 63

H
  Help
    Epson, 64 to 65
    software, 65
  Histogram adjustment, 27
  Home Mode, 19, 21 to 23, 33 to 34

I
  IEEE 1394, see FireWire
  Image Adjustment button, 27
  Image quality problems, 60 to 63
  Image Type setting, 30, 34
  Installing
    automatic document feeder, 43 to 45
    FireWire scanner interface card, 48 to 49
    Network Image Express card, 50 to 51
    software, 16 to 17

L
  Lights, 56
  Loading documents
    automatic document feeder, 45
    single sheet, 20
  Lock, transportation, 13, 54

M
  Maintenance, 53 to 54
  Moving scanner, 54

N
  Network Image Express card, 50 to 51

O
  OCR scanning, 8, 31 to 32
  Office Mode, 19, 21, 24 to 25, 29 to 30
  Optional equipment, see Automatic document feeder, FireWire, Network Image Express

P
  PaperPort Deluxe
    installing, 16 to 17
    support, 65
    using, 28 to 30
  Photoshop Elements, 32, 65
  Power, turning off, 13
  Power, turning on, 13
  Preview window, 37
  Problems
    automatic document feeder, 47 to 48, 56, 60
    color, 62 to 63
    image quality, 60 to 63
    previewing scan, 59
    scanner, 57 to 59
    software, 60
    Professional Mode, 19, 21, 26 to 28

R
  Ready light, 56
  Requirements
    electrical, 68
    environmental, 68
    system, 48, 71
  Resizing images, 39
  Resolution
    choosing, 27, 38 to 39
    maximum, 67
S

Safety instructions, 72
Scaling images, 39
Scanner
  choosing location, 12
  cleaning, 53
  connecting, 14 to 15
  installing software, 16 to 17
  moving, 54
  problems, 57 to 59
  turning off, 13
  turning on, 13
  unpacking, 11
Scanning
  color images, 39
  documents with PaperPort Deluxe, 28 to 30
  double-sided, 46
  photos, 32 to 34
  placing documents, 20
  previewing scans, 37 to 38, 59
  Start button, 35 to 36
  text for editing, 8, 31 to 32
  tips, 38 to 39
  to a file, 21
  with automatic document feeder, 46
Scanning Quality setting, 27
SCSI
  connecting to, 15
  interface specifications, 69
  problems, 58
Service, 64 to 65
Software
  installing, 16 to 17
  problems, 60
  uninstalling, 64
Specifications
  automatic document feeder, 70
  electrical, 68
  environmental, 68
  FireWire card, 69
  scanner, 67 to 70
Start button, 35 to 36
Support, 64 to 65
System requirements, 48, 71

T

Target Size setting, 27, 34
Technical support, 64 to 65
Text scanning, 8, 31 to 32
Tone correction, 27
Transportation lock, 13, 54, 58
Transporting scanner, 54
Troubleshooting
  automatic document feeder, 56, 60
  image quality, 60 to 63
  scanner, 57 to 59
  software, 60
Turning off scanner, 13
Turning on scanner, 13

U

Uninstalling software, 64
Unpacking scanner, 11
Unsharp Mask Filter, 25, 28, 30
USB
  connecting to, 14
  interface specifications, 69

W

Warranty, 74 to 75